
Experiment GB-3: Water Quality

Background
The acidity, salinity, conductivity, and many other 

properties of natural water systems depend on the 
conditions of the environment that surround the water 
systems. These properties determine the organisms that 
can live in the water system.

To maintain aquatic life in a water system, the 
properties of water quality need to be within a narrow 
range of values. For example, if the water system is too 
acidic (pH <4) or too basic (pH >9), it usually cannot 
sustain aquatic organisms. Other properties, like salinity, 
affect the species of organisms that can live within a 
water system; some species of fish only live in water 
with low or no salinity, while other species can only live 
in seawater.

The water that fills natural water systems may begin as 
rain that is slightly acidic, and becomes more acidic as it 
seeps through the leaves littering the forest floor. As the 
water percolates through the soil, it reverts to being less 
acidic and becomes basic as it moves through deposits 
of minerals, like limestone. These compounds in the 
ground usually balance each other, so that natural water 
systems have a pH between 4 and 9. 

The interactions of humans with the environment can 
alter the quality of water dramatically and affect the 
survival of aquatic life. Many natural water systems are 
surrounded by agricultural land. Nutrients in the soil and 
fertilizers applied to the land can alter the abundance of 
aquatic life in the water system. When these chemicals 
reach the water system, they can stimulate the growth of 
organisms, like algae, that actually deplete the water 
system of dissolved oxygen and affect the survival of 
fish in that water.

In this experiment, students will collect water samples 
from a variety of sources, like streams and ponds, 
around their community. They can also collect samples 
of tap water, water from swimming pools and drinking 
fountains, and deionized or distilled water for testing. 
Students will measure the temperature of the water at 
the site where it is collected. When the water samples 
are brought back to the laboratory, the students will 
measure the pH, dissolved oxygen concentration, and 
specific gravity of their samples. The values of these 
four parameters for each sample will be entered into a 
table for comparison.

Equipment Required
PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

ISE-730 Dissolved oxygen electrode 

DO2-100 Current to voltage adapter

ISE-100 combination pH electrode

Magnetic stirrer

Stir bars

200 ml flasks (4)

Nalgene plastic water sample bottles with caps

1000 ml beaker

Roll of plastic wrap

pH 4 and pH 7 buffer solutions

Thermometer

Hydrometer and cylinder

Deionized water

Zero-percent oxygen calibration solution

Collect Water Samples
1 Your instructor will organize the collection of water samples 

for your lab session. Sampling may be part of the regular 
lab session or may need to be completed before the lab 
session in which the samples are analyzed.

2 When going sampling, wear appropriate clothing for doing 
outdoor activities. Wear personal flotation devices where 
and when water safety precautions should be taken.

3 Check the contents of the water sampling kit to make it sure 
contains the appropriate number of clean and capped water 
sample bottles, sampling container and retrieval devices, 
thermometer, indelible marking pen, and protective gear like 
goggles and gloves.

4 Make sure the set of sample bottles have been cleaned and 
rinsed with distilled water. Attach a label to each bottle.

5 Proceed to the first collection site and collect a sample of 
water according to the directions for using the sampling 
equipment provided by your instructor.

6 Use the thermometer to measure the temperature of the 
water at the site where the sample was taken.

7 Fill the sample bottles as high as possible to insure there is 
no air in the bottle. Quickly and tightly cap the bottle.

8 Using the indelible marking pen, label the bottle with infor-
mation about the following parameters: the date and time of 
the collection; the name and location of the collection site; 
the weather conditions at the collection site; and, the 
temperature of the water at the collection site.

9 Repeat Steps 5 through 8 at other collection sites. Then, 
return to the lab for analysis of your water samples.
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IWX/214 Setup
1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure 1-1 in Chapter 1 for the location of the USB 
port and the power socket on the IWX/214.

3 Use the USB cable to connect the computer to the USB port 
on the rear panel of the IWX/214. 

4 Plug the power supply for the IWX/214 into the electrical 
outlet. Insert the plug on the end of the power supply cable 
into the labeled socket on the rear of the IWX/214. Use the 
power switch to turn on the unit. Confirm that the red power 
light is on.

Start the Software
1 Click the Windows Start menu, move the cursor to 

Programs and then to the iWorx folder and select 
LabScribe; or click on the LabScribe icon on the Desktop

2 When the program opens, select Load Group from the 
Settings menu.   

3 From the dialog box, select AddedLabs.iws. Click Load.

4 Click on the Settings menu again and select the Water 
Quality settings file.

5 After a short time, LabScribe will appear on the computer 
screen as configured by the WaterQuality settings.

6 If you want a digital display of the current dissolved oxygen 
concentration and pH level to appear on the Main window 
during the recording, open the View menu and select 
Voltmeter.

Dissolved Oxygen and pH Electrodes Setup
1 Plug one end of the DIN-DIN cable into Channel 3 on the 

iWorx unit. Plug the other end of this cable into the DIN 
connector on the DO2-100 current to voltage adapter 
(Figure GB-3-1 on page 2).

2 Attach the cable from the ISE-730 dissolved oxygen 
electrode to the BNC connector on the current to voltage 
adapter.

3 Plug the DIN connector on the end of the cable of the ISE-
100 pH electrode into Channel 4 on the iWorx unit.

Calibration of the Dissolved Oxygen Electrode
Aim: To calibrate the dissolved oxygen electrode.

The standard used for calibrating the dissolved oxygen 
electrode is the known concentration of oxygen in air-
saturated deionized water. The amount of oxygen that is 
dissolved in water is known as its solubility (S) and it is 
dependent upon the temperature, oxygen pressure in the 
air, and the concentrations of dissolved solutes in the 
water. Solubility (S) can be determined by using the 
following equation: 

S = (α/22.414) ((P-p)/P) (r%/100).

In this equation, α is the absorption coefficient of O2 at 
the temperature, p is the vapor pressure of water at the 
temperature, P is the barometric pressure, and r% is the 
percent oxygen in the air. For example, at 26oC and 
760mmHg and a concentration of oxygen in air of 21%, 
S equals:

(0.02783/22.414L/mole)(734.91mmHg/760mmHg)(0.21)

= 252µMO2 

 Figure GB-3-1: The setup for recording oxygen concentration levels and pH 
in a small closed ecosystem using the iWorx/214.

Procedure
1 Place the oxygen electrode in a 250 ml beaker containing 

room temperature deionized water. There needs to be 
enough water in the beaker to submerge the tip of the 
oxygen electrode, and keep its tip away from the stir bar in 
the beaker. Place the beaker on a magnetic stirrer. Adjust 
the speed of the stirrer so the stir bar is rotating quickly and 
evenly. 

2 Click Start on the LabScribe Main window to begin 
recording. The trace will eventually reach a stable baseline 
towards the top of the recording channel. Type the words 
Saturation-DI Water on the comment line to the right of the 
Mark button. Press the Enter key on the keyboard to mark 
the stable baseline of the recording. This comment marks 
the output of the oxygen electrode in room temperature 
deionized water that is saturated with as much oxygen as it 
can hold.

3 Obtain a beaker containing zero-percent oxygen calibration 
solution at room temperature. Make sure there is enough 
solution in the beaker to keep the tip of the electrode clear 
of the stir bar.Continue to record as you remove the oxygen 
electrode from the deionized water and place it in the 
beaker with the zero-percent oxygen calibration solution. 
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4 Turn off the magnetic stirrer. Remove the beaker of 
deionized water from the stirrer, and place the beaker 
containing zero-percent oxygen calibration solution on the 
stirrer. Turn on the stirrer and adjust the speed of the stirrer 
so the stir bar is rotating quickly and evenly.

5 The trace will move towards the bottom of the recording 
channel. Type the words No Oxygen on the comment line. 
Eventually, the trace will reach a stable baseline at the 
bottom of the recording channel. Press the Enter key on 
the keyboard to mark this new baseline. This comment 
marks the output of the oxygen electrode in a room temper-
ature solution that is depleted of oxygen.

6 Click Stop to halt the recording. 

7 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file (e.g., a class folder). Click the Save button to save the 
file (as an *.iwd file). 

8 Turn off the stirrer. Remove the electrode from the beaker of 
calibration solution. Hold the electrode over the beaker used 
for collecting waste liquid, and rinse it with deionized water 
from a wash bottle. Blot any drops of water from the 
electrode and place it in a beaker of deionized water.

Units Conversion-Dissolved Oxygen
1 Measure the temperature (oC) in the lab room. Assume the 

barometric pressure in the lab room is one atmosphere 
(760mmHg) and the concentration of oxygen in the air is 
21%. Look up the concentration of oxygen in deionized 
water for the temperature in the lab room on Table GB-3-1 
on page 3. This value will be used in Step 4 of this units 
conversion.

Table GB-3-1: Concentration of Oxygen [O2] in 
Air-Saturated Deionized Water at 1 Atmosphere.

2 Select the section of the recording before and after the 
oxygen is removed from the deionized water in the 
chamber. To view this section of the recording in its entirety 

on the same window, it may be necessary to click either of 
the Display Time icons in the LabScribe toolbar (Figure 
GB-3-2 on page 3). 

 Figure GB-3-2: The LabScribe toolbar.

3 Click the 2-Cursor icon (Figure GB-3-2 on page 3) so that 
two blue vertical lines appear over the recording window. 
Place one cursor on the left side of the plateau corre-
sponding to the oxygen concentration in air-saturated 
deionized water. Place the other cursor on the right side of 
the plateau corresponding to the oxygen concentration in 
the zero-percent oxygen calibration solution (Figure GB-3-3 
on page 3).

4 Right-click on the Channel 3 window to open the right-
click menu. Select Units from the right-click menu. Note 
that the voltage values for the positions of Cursors 1 and 2 
are already entered in the units conversion window. 

• Next to the voltage value for Cursor1, enter 0. 

• Next to the voltage value for Cursor2, enter the concen-
tration of oxygen dissolved in deionized water at room temper-
ature found on Table GB-3-1 on page 3. 

• Next to the unit name, enter µMolarO2. 

• Click OK. The units on the Y-axis are equal to the µmoles of 
oxygen in a liter of deionized water.

 Figure GB-3-3: Recording used to convert units of the Y-axis from voltage to 
O2 concentration (µMolar).

Calibration of the pH Electrode
1 If the pH electrode is still stored in its bottle of buffer, 

remove the electrode from the bottle. Rinse the electrode 
with deionized water while holding the electrode over a 
1000 ml beaker used for the collection of waste liquids.

2 Place the tip of the pH electrode in a 250 ml beaker 
containing enough room temperature deionized water to 
submerge the tip. Keep the electrode in deionized water for 
at least ten minutes.

Temp
(oC)

O2 Abs Coeff  
(a)

H2O Vapor Press 
(p in mmHg)

[O2] 
(µM)

20 .03102 17.54 284

21 .03044 18.65 278

22 .02988 19.83 273

23 .02934 21.07 267

24 .02881 22.38 262

25 .02831 23.76 257

26 .02783 25.09 252

27 .02736 26.74 247

28 .02691 28.35 243

29 .02649 30.04 238

30 .02608 31.82 234
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3 Prepare two 100 ml beakers filled with the pH buffers used 
for calibrating the pH electrode. The buffers should be a 
room temperature. One beaker is filled with pH 7 buffer; and 
the other is filled with pH 4 buffer. Each beaker should be 
filled with enough buffer to cover the tip of the pH electrode, 
and also allow the stir bar in the beaker to spin without 
touching the pH electrode.

4 Place the beaker containing the pH 7 buffer on the magnetic 
stirrer. Carefully place a stir bar in the beaker. Remove the 
pH electrode from the deionized water and blot any drops of 
water from the electrode. Position the tip of the electrode in 
the beaker of pH 7 buffer so that the tip is away from the stir 
bar. Adjust the speed of the stirrer so the stir bar is rotating 
evenly at a moderate speed. 

5 Click Start on the LabScribe Main window to begin 
recording. The trace will eventually reach a stable baseline 
toward the top of the recording channel. Type the words 
Calibration - pH 7 on the comment line to the right of the 
Mark button. Press the Enter key on the keyboard to mark 
the stable baseline of the recording. This comment marks 
the output of the pH electrode in pH 7 buffer at room 
temperature. Continue recording while changing the 
beakers of buffers.

6 Turn off the stirrer and remove the pH electrode from the 
beaker of pH 7 buffer. Hold the electrode over the beaker 
used for collecting waste liquid, and rinse it with deionized 
water from a wash bottle. Blot any drops of water from the 
electrode.

7 Remove the beaker of pH 7 buffer from the stirrer and place 
the beaker of pH 4 buffer on the stirrer. Carefully place a stir 
bar in the beaker. Position the tip of the pH electrode in the 
beaker of pH 7 buffer so that the tip of the electrode is away 
from the stir bar. Adjust the speed of the stirrer so the stir 
bar is rotating evenly at a moderate speed.

8 As you continue to record, the trace will reach a stable 
baseline toward the bottom of the recording channel. Type 
the words Calibration - pH 4 on the comment line to the 
right of the Mark button. Press the Enter key on the 
keyboard to mark the stable baseline of the recording. This 
comment marks the output of the pH electrode in room 
temperature pH 4 buffer. Click Stop to halt the recording. 

9 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file (e.g., a class folder). Click the Save button to save the 
file (as an *.iwd file). 

10 Turn off the stirrer. Remove the pH electrode from the 
beaker of pH 4 buffer. Hold the electrode over the beaker 
used for collecting waste liquid, and rinse it with deionized 
water from a wash bottle. Blot any drops of water from the 
electrode and place it in a beaker of deionized water.

Units Conversion-pH
1 Locate the section of the recording where output of the pH 

electrode was measured in pH 4 and pH 7 buffers. To view 
this section of the recording in its entirety on the same 
window, it may be necessary to click either of the Display 
Time icons in the LabScribe toolbar (Figure GB-3-2 on 
page 3). 

2 Click the 2-Cursor icon (Figure GB-3-2 on page 3) so that 
two blue vertical lines appear over the recording window. 
Place one cursor on the plateau recorded while the pH 
probe was in pH 7 buffer. Place the other cursor on the 
plateau recorded while the pH probe was in pH 4 buffer.

3 Right-click on the Channel 4 window to open the right-
click menu. Select Units from the right-click menu. Note 
that the voltage values for the positions of Cursors 1 and 2 
are already entered in the units conversion window. 

• Next to the voltage value for Cursor1, enter 7. 

• Next to the voltage value for Cursor2, enter 4. 

• Next to the unit name, enter pH.

• Click OK. The units on the Y-axis are equal to pH units.

Exercise 1: Dissolved Oxygen Concentration of 
a Water Sample

Aim: To measure the dissolved oxygen concentration 
of a water sample.

Procedure

Warning: Use gloves, goggles, and lab coats when 
handling water samples.

1 Place a magnetic stirrer on or next to the base of a 
ringstand. Open the first water sample bottle and place a stir 
bar in the bottle. Place the cap on the bottle and turn it until 
it is tight. Turn on the stirrer and position the stir bar in the 
center of the bottom of the bottle (Figure GB-3-1 on page 2). 
Turn off the stirrer before Step 2.

2 Remove the dissolved oxygen electrode from the beaker of 
deionized water. Blot the drops of deionized water from the 
electrode. Mount the electrode on the ringstand using a 
clamp.

3 Remove the cap from water sample bottle, loosen the clamp 
holding the dissolved oxygen electrode, and place the tip of 
the electrode in the water sample as close to the center of 
the bottle as it will go. Quickly seal the opening of the bottle 
around the electrode with parafilm or plastic wrap to prevent 
the exchange of gases between the water sample and the 
environment.

4 Turn on the stirrer so that the stir bar rotates evenly and 
moderately. Wait two minutes before recording the 
dissolved oxygen concentration of the water sample.

5 Click Start on the LabScribe Main window to begin 
recording. When the recording reaches a stable level on 
[Oxygen] channel, type DO2 and the name of the location 
where the sample was taken on the comment line to the 
right of the Mark button. Press the Enter key on the 
keyboard to mark the recording.

6 Click Stop to halt the recording. 

7 Select Save in the File menu. Complete Step 8 and then 
proceed directly to Exercise 2.
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8 Remove the dissolved oxygen electrode from the water 
sample. Hold the electrode over the beaker used for 
collecting waste liquid, and rinse it with deionized water 
from a wash bottle. Blot any drops of water from the 
electrode and place it in a beaker of deionized water.

Exercise 2: pH of a Water Sample
Aim: To measure the pH of a water sample which 

indicates the acidity of the water.

Procedure
1 As soon as the dissolved oxygen concentration of the first 

water sample is recorded, record the pH of the same water 
sample.

2 Remove the pH electrode from the beaker of deionized 
water. Blot the drops of deionized water from the electrode. 
Mount the electrode on the ringstand using a clamp.

3 Loosen the clamp holding the pH electrode, and place the 
tip of the electrode in the water sample as close to the 
center of the bottle as it will go. 

4 Turn on the stirrer so that the stir bar rotates evenly and 
moderately. Wait thirty seconds before recording the pH of 
the water sample.

5 Click Start on the LabScribe Main window to begin 
recording. When the recording reaches a stable level on the 
pH channel, type pH and the name of the location where 
the sample was taken on the comment line to the right of 
the Mark button. Press the Enter key on the keyboard to 
mark the recording.

6 Click Stop to halt the recording. 

7 Select Save in the File menu. Complete Step 8 and then 
proceed directly to Exercise 3.

8 Remove the pH electrode from the water sample. Hold the 
electrode over the beaker used for collecting waste liquid, 
and rinse it with deionized water from a wash bottle. Blot 
any drops of water from the electrode and place it in a 
beaker of deionized water.

9 Proceed directly to Exercise 3.

Exercise 3: Specific Gravity of a Water Sample
Aim: To measure the specific gravity of a water sample 

which indicates the concentration of dissolved solutes, 
like sodium and potassium and chloride, in the sample.

Procedure
1 Transfer enough of the first water sample to the hydrometer 

cylinder to fill about 80% of the cylinder.

2 Place the hydrometer in the cylinder and gently spin the 
device so that it rotates freely for at least two turns.

3 Read the specific gravity of the water sample by matching 
the meniscus of the sample with scale on the stem of the 
hydrometer. The scale ranges from 1.000 at the top to 1.060 
at the bottom.

• If the specific gravity of a water sample is too high (>1.060), 
measure a given volume of sample and dilute that volume by 
adding one or two times more deionized water. 

• Account for the dilution when the specific gravity of the 
sample is recorded. For example, if one volume of deionized 
water was added to one volume of sample and the hydrometer 
read 1.02, specific gravity would be calculated by:

a) Subtracting 1.000 (specific gravity of water) from 
1.020 = 0.02;

b) Multiplying the difference (0.02) x 2 (for 2 volumes) 
= 0.04; and

c) Adding 0.04 to 1.000 = 1.04, the specific gravity of 
sample.

4 Record the specific gravity of the first water sample on 
Table GB-3-2 on page 6 and in the Journal.

Other Water Samples
Repeat Exercises 1, 2, and 3 for the other water 

samples that were collected.

Data Analysis
1 Scroll to the section of data recorded during Exercise 1.

2 Click on the 1 cursor icon on the LabScribe toolbar. Place 
the cursor in the middle of the stable oxygen saturation level 
recorded on the [Oxygen] channel for the first water 
sample. 

3 Read the dissolved oxygen concentration next to the term. 
Value =, in the upper right margin of the [Oxygen] channel.

4 Record the oxygen saturation level of the first water sample 
in Table GB-3-2 on page 6 and in the Journal.

5 Scroll to the section of data recorded during Exercise 2. 
Place the single cursor in the middle of the stable pH level 
recorded on the pH channel for the first water sample. 

6 Read the dissolved oxygen concentration next to the term. 
Value =, in the upper right margin of the pH channel.

7 Record the pH level of the first water sample in Table GB-3-
2 on page 6 and in the Journal.

8 Record the temperature of the first water sample taken at 
the collection site to Table GB-3-2 on page 6 and the 
Journal.

9 Repeat Steps 1 through 8 for each of the other water 
samples.
General Biology Chapter 5



Questions
1 Which sample had the highest dissolved oxygen concen-

tration? What caused that sample to have that level of 
oxygen saturation?

2 Which sample had the lowest dissolved oxygen concen-
tration? What caused that sample to have that level of 
oxygen saturation?

3 Which sample had the highest pH level? What caused that 
sample to have that pH level?

4 Which sample had the lowest pH level? What caused that 
sample to have that pH level?

5 Which sample had the highest specific gravity? What 
caused that sample to have that level of specific gravity?

6 Which sample had the lowest specific gravity? What caused 
that sample to have that level of specific gravity?

7 Does your data indicate any correlation between pH level 
and oxygen saturation level, or oxygen saturation level and 
specific gravity, or any other combination of parameters?

Appendix
Zero-Percent Oxygen Calibration Solution is 15mM 

Sodium Hydrosulfite in deionized water.

Table GB-3-2: Values for Four Parameters Recorded from Water Samples.

Water Sample/Locat ion
Temperature

oCels ius

Dissolved Oxygen 
Concentrat ion 

(µMolar O2)
pH Speci f ic  

Gravi ty

1

2

3

4

5

6

7
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